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Introduction 
Importing your LessonBuilder lesson into the Blackboard course management 
system (CMS) is very easy.  There are two different ways to package and import 
your lesson into Blackboard – using a standard zip format, or using a SCORM zip 
format. 
 

Which Packaging Format Should I Use? 
You may be wondering what is the difference between packaging and importing 
your lesson as standard zip versus SCORM zip.   The standard zip packaging 
and the SCORM zip packaging both present your LessonBuilder content in 
similar ways to the student.  The primary benefit of using SCORM packaging is 
that it allows you to have your student’s lesson score automatically recorded in 
the Blackboard gradebook, and it allows you to track the amount of time the 
student spent on the lesson, as well as whether you students have completed a 
lesson.  
 
Whether you use the standard zip packaging format, or the SCORM zip 
packaging format also depends on your whether your Blackboard system 
supports SCORM.  The SCORM packaging format should only be used if your 
Blackboard system supports SCORM.  Below is information about SCORM 
support for different versions of Blackboard: 
 
 Blackboard 6.3 or newer:  SCORM is supported in both Basic and 
Enterprise versions of the Blackboard Learning System.  Both SCORM 1.2 and 
SCORM 2004 are supported. 
 
 Blackboard 6.0-6.2:  SCORM is supported only in the Enterprise version 
of the Blackboard Learning System.  Only SCORM 1.2 is supported. 
 
 Blackboard versions 5 and previous:  SCORM is not supported in these 
versions of Blackboard. 
 
 
If you aren’t sure what version of the Blackboard system you have or whether 
your Blackboard CMS supports SCORM, check with your Blackboard system 
administrator.   
 
If your Blackboard system administrator needs additional information about 
SCORM support in Blackboard, please have them review the following section 
titled What is SCORM and the section titled SCORM information for Blackboard 
System Admins below. 
 
All versions of Blackboard allow you to import your lesson using the standard zip 
format.  The standard zip format allows you to import your LessonBuilder lesson 



and then unpackage it in Blackboard. Lessons packaged using the standard zip 
format do not allow the quiz results to be automatically added into the 
Blackboard gradebook. 
 
 
 

What is SCORM? 
What is SCORM and how is it useful? 
 
The Sharable Content Object Reference Model (SCORM) is a set of technical 
standards that have been developed with the specific purpose of enabling the 
reuse of Web-based learning content across multiple environments and products.   
If your lesson content is SCORM compliant, then you can use the content in any 
course management system that supports SCORM without having to make any 
modifications to the content.  Additionally, the SCORM standards allow your 
content to interface automatically with specific components of the course 
management system, for example the gradebook. 
 
The result is that if you package your LessonBuilder lesson in a SCORM zip 
format and then import it into a SCORM conformant version of Blackboard, then 
the quiz results from your LessonBuilder lessons can be automatically recorded 
by Blackboard in its gradebook.  Additionally, using SCORM, Blackboard can 
keep track of the amount of time a student spent on the lesson, and whether a 
student has completed a LessonBuilder lesson.  In the future, as the SCORM 
standard is further developed, additional integrations between a SCORM 
formatted lesson and Blackboard will become available.   
 
Another benefit of using SCORM is that a lesson that is packaged in SCORM 
format can be readily used in any course management system that is SCORM 
compliant.  Therefore, if you wish to create content that is not “stuck” in a 
proprietary format and useable in only one course management system, SCORM 
allows you to create content that can be readily reused in many different course 
management systems with no need to revise the content. 
 

Using Standard Zip Format 
All versions of Blackboard allow you to import your lesson using the standard zip 
format.  The standard zip format allows you to import your LessonBuilder lesson 
and then unpackage it in Blackboard. Lessons packaged using the standard zip 
format do not allow the quiz results to be automatically added into the 
Blackboard gradebook. 
 



Step-by-Step for Standard zip Format 
When you have completed creation of your LessonBuilder lesson, use 
LessonBuilder’s Package feature to package the lesson into a “zip” file for easy 
portability to a web site, or import into most course management systems. 

 

 
 
 
Save the lesson before packaging it.  
 
Choose the File menu, Package lesson/Zip Format 
 
LessonBuilder will create a zip file archive containing your lesson and all 
of its associated files.   Once the packaging process is complete, 
LessonBuilder displays a message telling you the location of the packaged 
zip file.  Note this location. 
 
Login to Blackboard and access the Control Panel of your course.   
 
Click to select one of the Content Areas of your course, such as Course 
Documents or Assignments. 
 
Click Add Item and specify a name for your lesson.   
 
On the Add Item form that is displayed, leave the Text Box blank, and click 
the Browse button associated with File to Attach.  Browse your 
computer’s disk drive to locate the zip file that was created when you 
packaged your lesson.  Then, click the Open button. 
 
In the Special Action menu, select Unpackage this file. 
 



 
 
 
Submit the Blackboard form. 
 
The Package Entry Point form will be displayed.  You will be prompted to 
select an Entry Point for the lesson.  Your LessonBuilder lesson will 
contain many files.  The entry point file is always an html file that has the 
name “index.html”.   
 
Submit the form. 
 
Your LessonBuilder lesson will be displayed within Blackboard.  
 
If you need to modify your lesson, you should modify it in LessonBuilder.  
Then, remove the existing lesson from Blackboard and replace it with the 
revised version of your lesson using the same procedure as described 
above. 
 

 
 



Using SCORM Format 

 

Blackboard version 6.3 and higher 
Following are step-by-step instructions for packaging a LessonBuilder lesson and 
importing it into the Blackboard CMS version 6.3 or higher.   
 
When you have completed creation of your LessonBuilder lesson, use 
LessonBuilder’s Package feature to package the lesson into a “zip” file for easy 
portability to a web site, or import into most course management systems. 

 
Save the lesson before packaging it.  
 
Choose the File menu, Package lesson/SCORM 1.2 format. (Note: 
SCORM 2004 format is supported in this version of Blackboard; however 
our initial testing found problems with the SCORM 2004 format.  We 
suggest you use the SCORM 1.2 format if you experience any problems 
with the SCORM 2004 format.  Both formats provide the same 
functionality.) 
 
LessonBuilder will create a zip file archive in SCORM format containing 
your lesson and all of its associated files.   Once the packaging process is 
complete, LessonBuilder displays a message telling you the name of the 
packaged zip file.  The packaged zip file is always named the same as 
your lesson filename with the addition of _sco.zip (for SCORM 1.2 
formats) or _sco2004.zip (for SCORM 2004 formats).   
 
So, for example, if your lesson file is named Jefferson, the SCORM 1.2 zip 
file will be named Jefferson_sco.zip, and it will be located in the folder 
where you saved your lesson. 
 
Login to Blackboard and access the Control Panel of your course.   
 
Click to select one of the Content Areas of your course, such as Course 
Documents or Assignments. 
 
Look for the drop-down menu at the top of the Content Area window that 
has Learning Unit displayed.  Click the drop-down menu arrow to view all 
of the types of content you can add to Blackboard.  Choose SCORM 
Content from the drop-down menu.  Then click the GO button. 
 
 



 
 
 
 
NOTE: If you do not see an option for SCORM Content in the drop-down 
menu, then your Blackboard system does not currently support SCORM, 
or it has not been enabled in your system.  Ask your Blackboard System 
Administrator for assistance.  For more information, see the section below 
titled SCORM information for Blackboard System Admins 
 
On the Add SCORM Content form that is displayed, enter a title for your 
lesson, and then click the Browse button associated with Attach Local 
File, or click the Browse button associated with copy file from Content 
Collection.  Browse your computer’s disk drive (or the content system) to 
locate the SCORM zip file that was created when you packaged your 
lesson.  Then, click the Open button. 
 
Make any other selections you wish under Options (we suggest you 
choose the Flow navigation option), and then Submit the form.   
 
Under Gradebook Options, if you choose the option to Add Gradebook 
Item, you will be presented with a screen to select and name the 
gradebook item.  You may also select to Track Attempt Details.  This will 
allow question specific responses for each student to be tracked in the 
gradebook.   
 
 
After completing the SCORM dialog and Gradebook dialogs, your 
LessonBuilder lesson will be displayed within Blackboard. 
 
If you chose to Add SCORM scores to the Gradebook, you should now be 
able to find an item in your Blackboard gradebook related to the Lesson.   
 
If you need to modify your lesson, you should modify it in LessonBuilder.  
Then, remove the existing lesson from Blackboard and replace it with the 
revised version of your lesson using the same procedure as described 
above. 

 
 



 

Blackboard version 6.0-6.2 
Following are step-by-step instructions for packaging a LessonBuilder lesson and 
importing it into the Blackboard CMS version 6.0-6.2.   
 
When you have completed creation of your LessonBuilder lesson, use 
LessonBuilder’s Package feature to package the lesson into a “zip” file for easy 
portability to a web site, or import into most course management systems. 

 
Save the lesson before packaging it.  
 
Choose the File menu, Package lesson/SCORM 1.2 format. (Note: 
SCORM 2004 format is not supported in this version of Blackboard.) 
 
LessonBuilder will create a zip file archive in SCORM format containing 
your lesson and all of its associated files.   Once the packaging process is 
complete, LessonBuilder displays a message telling you the name of the 
packaged zip file.  The packaged zip file is always named the same as 
your lesson filename with the addition of _sco.zip.  So, for example, if 
your lesson file is named Jefferson, the SCORM zip file will be named 
Jefferson_sco.zip, and it will be located in the folder where you saved your 
lesson. 
 
Login to Blackboard and access the Control Panel of your course.   
 
Click to select one of the Content Areas of your course, such as Course 
Documents or Assignments. 
 
Look for the drop-down menu at the top of the Content Area window that 
has Learning Unit displayed.  Click the drop-down menu arrow to view all 
of the types of content you can add to Blackboard.  Choose SCORM 
Content from the drop-down menu.  Then click the GO button. 
 

 
 
NOTE: If you do not see an option for SCORM Content in the drop-down 
menu, then your Blackboard system does not currently support SCORM, 
or it has not been enabled in your system.  Ask your Blackboard System 



Administrator for assistance.  For more information, see the section below 
titled SCORM information for Blackboard System Admins 
 
On the Add SCORM Content form that is displayed, enter a title for your 
lesson, and then click the Browse button associated with Content 
Package.  Browse your computer’s disk drive to locate the zip file that was 
created when you packaged your lesson.  Then, click the Open button. 
 
Make any other selections you wish under Options (we suggest you 
choose the Flow navigation option), and then Submit the form.   
 
If you chose the option to Add SCORM scores to the Online 
Gradebook, you will be presented with a screen to select and name the 
gradebook item.  (Note that if two items with the same name are 
presented, choose the second item in the list.)  Submit the form. 
 

 
 
 
Your LessonBuilder lesson will be displayed within Blackboard. (Note that 
in this version of Blackboard, SCORM content is always added as the 
second item in the list of items on a page, rather than at the end of the list 
of items on a page.  You may use the standard Blackboard content 
ordering drop-down menus to modify the order of the content.) 
 
If you chose to Add SCORM scores to the Gradebook, you should now be 
able to find an item in your Blackboard gradebook related to the Lesson.   
 
You may also view a list of students who have attempted or completed a 
lesson by navigating to your Blackboard course menu (the button bar of 
your course), and then choose Tools.  From the Tools Menu, choose 
SCORM Learning Plan.   
 
If you need to modify your lesson, you should modify it in LessonBuilder.  
Then, remove the existing lesson from Blackboard and replace it with the 
revised version of your lesson using the same procedure as described 
above. 
 
 
 



Blackboard version 5.0/5.5 
SCORM is not supported in these versions of the Blackboard Learning 
Management System. 
 
 
 

SCORM information for Blackboard System Admins 
 
Blackboard 6.2 and higher:  Both Blackboard Basic Edition and Blackboard 
Enterprise edition support SCORM in this version.  It is included as part of the 
standard Blackboard system.   
 
Blackboard 6.0 and 6.1:   Only the Enterprise Edition of the Blackboard 
Learning System supports SCORM in this version.  In these versions, SCORM is 
supported through a Blackboard Building Block plugin.   The Blackboard System 
Administrator must install the Blackboard Content Player Building Block, in 
order to allow SCORM content to be added to the Blackboard system.  Please 
consult your Blackboard documentation or contact Blackboard technical support 
for additional information about installing the Blackboard Content Player Building 
Block. 
 
Blackboard 5 does not support the SCORM format.   
 
The SCORM tool is available to instructors through the Control Panel. From an 
Instructor perspective they can use this tool within the content areas as they 
add/modify content items within their course. Instructors and Students interact 
with IMS, SCORM, and NLN content just as they would with other types of 
Content Items. 
 

Need Assistance? 
If you have any problems, questions, or comments regarding installation or use 
of SoftChalk LessonBuilder with the Blackboard CMS, please contact us at 
help@softchalk.com , or visit the web site at http://www.softchalk.com 
 
Thank you for your support!  We hope you enjoy using SoftChalk LessonBuilder! 
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